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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published December 2020. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction 
or distribution of the program or any portion thereof could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
Open Plan is an enterprise-class project management software solution that offers the power and 
flexibility to complete medium to large or multiple projects on time and on budget. With multi-project 
analysis, critical path planning and resource management, Deltek Open Plan offers the power and 
flexibility to serve the differing needs of business, resource and project managers. With Deltek Open 
Plan, you can improve project success, allocate resources across projects more effectively and share 
project information across the enterprise. 

This document is meant to serve as a guideline for hardware and software requirements and provide your 
firm’s IT department with information about the technical deployment architecture. 

It is important to note that the choices of hardware, relational database software, and operating systems 
in these examples represent guidelines, are subject to change, and do not replace a needs analysis and 
site survey with a Deltek Technical Consultant. Contact a Deltek Technical Systems Engineer for 
suitability of legacy equipment. 

Consulting 
Deltek, Inc. can provide onsite consulting and training services as well as phone support on a contract or 
time-and-materials basis. 

Contact Information 
Please contact a Deltek Technical Systems Engineer techse@deltek.com for more information.  

Additional Notes 
Legal Disclaimer: The recommendations in this document are intended to convey general information 
and should not be relied upon as a substitute for a professional consultation with Deltek. All the 
information in this document is provided “as is” and without warranties of any kind, either expressed or 
implied. 

Note: The evolution of technology dictates the way IT professionals plan their network hardware and 
software environments. While this document does not account for all possible options in the deployment 
of Deltek software, it does provide specific recommendations based on testing metrics and years of 
experience working directly with Deltek customers. Prior to making assumptions on how specific 3rd party 
technologies will perform with Deltek applications, Deltek recommends contacting your sales 
representative to arrange a discussion with a Deltek Technical Systems Engineer who can help you plan 
for a cost-effective and optimally performing application environment. 

  

mailto:techse@deltek.com


Overview 

Installation Guide 2 

 

Adding Custom Notes to This Guide 
If you would like to add custom notes to this guide that are specific to your company, Adobe® Reader® X 
provides this ability. If you do not already use Adobe Reader X, you can download it here free from 
Adobe.  

To add a custom note using Adobe Reader X, complete the following steps: 
1. On the Reader toolbar, click Comment at the far right. 

2. In the Annotations pane that displays, click  Sticky Note. The cursor changes to match the 
button. 

3. Position the cursor at the location in the guide where you want the note to appear, and click. A 
note icon is inserted at the location and a text box pops up. 

4. Enter your information in the text box.   

5. Continue adding notes as needed. 

6. Save the document. 

 
When reading the document, cursor over a note icon to see the information. Double-click a note icon to 
edit the information. 

Note: Deltek recommends that you save the document to a slightly different filename so as to keep 
the original from being overwritten. 

http://get.adobe.com/reader/
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Downloading Deltek Products using Deltek 
Software Manager 
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use 
Deltek Software Manager Lite to download Deltek products. 

Accessing DSM from within the Deltek Support Center 
To access DSM from within the Deltek Support Center: 

1. In your Web browser, go to https://deltek.custhelp.com.  

2. Enter your Deltek Support Center Username and Password, and click Login. 
3. When the Deltek Support Center page displays, click Product Downloads. 

4. On the Deltek Software Manager screen, click Launch Deltek Software Manager. 
5. Click Settings at the top right of the dialog box to use the Settings dialog box to specify the folder 

where you want to download Deltek products, and click OK.  

 
6. In the left pane, expand the Deltek product that you want to download, if it is not already 

expanded.  

7. Select the product type that you want to download.  

Options include: 

 Complete 
 Cumulative Updates 
 HotFixes 
 Sub-Release 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download.  

The right pane displays a message stating that the product has been added to the download 
queue. 

 
9. Click Download at the bottom of the left pane to download the product to the folder that you 

selected.  

Note: When you log on for the first time, DSM asks you to select a default folder where 
Deltek products are to be downloaded. 

You can change this folder anytime in the Settings dialog box. 

Note: To view the items in the download queue, click View Download Queue at the bottom 
of the left pane. 

https://deltek.custhelp.com/
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Accessing DSM Lite 
To access Deltek Software Manager Lite: 

1. In your Web browser, go to https://dsm.deltek.com/DeltekSoftwareManagerLite.  

2. Enter your Deltek Support Center Username and Password, and click Logon. 
3. When the Deltek Software Manager Lite page displays, select a product from the drop-down list. 

4. Click the product type that you want to download.  

 

DSM Documentation and Troubleshooting 
 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

Note: The download behavior and download folder may differ depending on the browser and 
browser settings that you are using. 

Note: When you click a link, you will be asked to log into DSM if you aren’t already logged in. 

https://dsm.deltek.com/DeltekSoftwareManagerLite
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://deltek.custhelp.com/app/answers/detail/a_id/50668
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Pre and Post-Installation Checklists 

Preinstallation Checklist 

Steps Related Topics 

1. Verify that you have the supported operating system and 
database platforms installed for the database and client 
tiers. 

 System Requirements 

2. Verify that you have at least 150MB of disk space available 
for this installation. 

 

3. Verify that the user account performing the installation is a 
member of the local Windows System Administrators group. 

 

4. Open Plan is installed and configured to use a Microsoft 
Access database by default and does not require that you 
have an MS SQL Server or Oracle database in order to use 
the software.  

If you plan to use an Oracle or MS SQL Server database, 
see Appendix B and the instructions in Set Up a Database.  

 Appendix B: Open Plan 
Databases 

 Set Up a Database 

Post-Installation Checklist 

Steps Related Topics 

1. Verify that users have permissions for the Open Plan 
folders. 

 Give Users the Appropriate 
Open Plan Folder 
Permissions 

2. Verify that users and groups have been added to the Deltek 
EPM Security Administrator. 

 Launch the Deltek EPM 
Security Administrator 

3. Open Plan is pre-configured to use an included Access 
database by default. 

If you wish to use Open Plan with a SQL Server or Oracle 
database, follow these steps to create and configure the 
database for use with Open Plan. 

1. Set up the database. 

2. Set up a data source for the database. 

3. Load the default data for the database. 

 Set Up a Database 

 Set Up a Data Source for a 
New Database 

 Load Default Data 
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Before You Begin Deployment 
Before you begin deployment, it is important to understand the following: 

 Logical Tiers 

 Installation / Deployment Models 

 Hardware and Software Requirements 

Logical Tiers Overview 
Open Plan uses a two-tier architecture. The logical tiers are as follows: 

 Client / Application Tier — This tier performs Open Plan’s functional process logic and provides 
the user interface layer. This tier can be a workstation or a Citrix/Terminal Server. 

 Database Tier — This tier consists of a database server where the Open Plan data is stored and 
retrieved. 

Installation/Deployment Models 

Stand-Alone Deployment 
The stand-alone model is designed for a single-user setup. The client, application, and database tiers all 
reside on the same machine.  

Client/Server Deployment 
In the client/server model, you install the client / application tier on workstations that directly connect to a 
database server. However, when a client workstation that is connected to the database goes through a 
router or a firewall, this type of setup often yields poor performance. This model can be deployed in a 
Citrix / Terminal Server environment to improve performance in that scenario.  
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In addition, the Multi-User (Server) install can be performed, where the application files reside on a 
network file share and the Workstation installation is performed on each workstation. 

 

Unsupported Scenarios 
The Open Plan installation does not support installing any Open Plan tiers on any of the following servers: 

 Domain Controller 

 Microsoft Exchange Server 

 Proxy, Firewall, or ISA Server 

 Microsoft SharePoint Portal Server 

 Installing any Open Plan Tier on Small Business/Essential Business Server 

Using these services / servers can cause significant issues in the performance, reliability, and 
functionality of the Open Plan application and the other applications on your network. 
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System Requirements 
Your organization has made a substantial commitment to ensure it has a fully integrated earned value 
management (EVM) solution. To support that commitment, Deltek recommends that you carefully 
consider the hardware requirements necessary to run Open Plan properly.  

Platform Virtualization  
Platform Virtualization is a technology that allows multiple operating systems and platforms to run 
simultaneously as separate virtual machines on a single set of server hardware.  

Deltek recognizes the use of virtual and cloud environments by our customers. Cloud environments 
consist of hosted resources that typically include virtual environments made available over the internet, 
such as “Amazon Web Services”. Virtual environment software, such as VMware®, resides in the 
hardware layer underneath the operating system and is used to partition a single server or cloud 
environment into a multiple server/multiple operating system environment. Deltek’s product development 
makes extensive use of cloud and virtualized environments. 

Support of Virtual Environments 
Deltek supports customers who run its products on any of the supported native operating systems 
(whereby “native operating systems” means any operating system specified in the Deltek Product Support 
Compatibility Matrix available on the Deltek Customer Care Connect site), irrespective of whether or not 
they are running in a cloud and/or a virtualized environment. However, Deltek does not have the capacity 
to rigorously test its products inside the many available cloud and virtualized environments. 

Each cloud and virtual environment software supports a set of operating systems and hardware certified 
by the software operating system and cloud/hardware vendors. The customer and virtualization vendor 
are responsible for any interactions and/or issues that arise at the hardware or operating system layer as 
a result of their use of a cloud-based environment and/or virtualization software. Virtualization software is 
supplied in both production and non-production versions. Deltek will only support the use of its products 
inside virtualization products that are recommended by the virtualization vendors for enterprise production 
use, and as further described below. 

Troubleshooting and Fixes 
The following conditions apply to those Deltek customers who experience issues with the Deltek software 
while using such products inside cloud and/or virtual environments: 

 Deltek customers will not be required to recreate and troubleshoot every issue in a non-cloud or 
nonvirtualized environment. 

 Deltek may request its customers to diagnose issues in a native certified operating system 
environment without the use of virtualization and/or within a non-cloud based environment. Deltek 
will only make this request when there is reason to believe that the cloud or virtual environment is 
a contributing factor to the issue. 

 Software problems will only be fixed if they can be replicated in a dedicated local hardware and 
operating system environment without the use of virtualization. 

Deltek Customer Support is unable to accept virtual images from customers in order to evaluate problems 
in deployments using virtualization. 
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Performance 
The use of cloud-based environment and/or virtualization software adds software overhead which may 
impact performance or scalability of all Deltek software products. The customer should not interpret any 
Deltek performance recommendations for the Deltek software on a dedicated hardware platform as 
directly applicable to one or more cloud or virtual environments running on the same or similar hardware. 
The customer should consult with its cloud and/or virtualization software vendor with respect to virtual 
system performance and tuning. 

Recommendation 
Deltek will continue to develop knowledge about the use of virtualization software solutions as these 
solutions continue to mature and extend into our user communities’ information technology infrastructure. 
Deltek strongly recommends that its customers deploy the Deltek software in a nonproduction 
environment when initially utilizing virtualization technology as a first step. By doing so, the customer will 
allow for resolution of any issues and customer-specific performance data to be developed for the virtual 
environment solution, without having an adverse impact on production operations. Please contact Deltek 
Customer Support for additional information on use of the Deltek software in a virtualized environment. 

Display Settings 
Deltek recommends a display resolution of 1920 x 1080 with a minimum resolution of 800 x 600. 

Using Open Plan with Citrix or Remote Desktop 
If you are integrating Open Plan with PM Compass, the PM Compass Smart Client application uses the 
Microsoft .NET Framework ClickOnce deployment technology which makes it easy for administrators to 
deliver Windows-based applications to end-users by sending them a URL. However, in some cases, the 
ClickOnce deployment behavior may not be supported.  

Hardware Sizing Considerations 
There are several factors that go into sizing an appropriate server infrastructure. The number of concurrent 
users accessing the system at any given time, the amount of data being analyzed, and growth expectations 
all have an impact on the initial sizing plans. The hardware profiles provided in the previous sections are 
intended as a starting point for deployment. It is expected that our clients will use the product in many 
different ways, plan for future release, and client customizations will all impact the growth and scaling of 
the overall solution. Further in-depth discussion of the business needs of the solution during 
implementations of application will provide final guidance on hardware requirements. 

Memory Requirements for Typical/Average Use 
Below are details on the memory footprint of the product. This can be helpful when sizing a client tier that 
runs in a virtual environment, Citrix, or Terminal Server. 

Tier Memory* 

Client Tier  50 MB for an Open Plan project with about 2,000 activities, 
2,000 relationships and 4,000 resource assignments (plus 
memory required by the database driver being used). 
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Tier Memory* 

Application Tier 
(Citrix/Terminal Server only) 

 Please see your vendor for recommendations. 

Database Tier  Database instance memory should be 10% - 15% of the 
database size. For example, if database size is expected to be 
500GB then allocate 50GB - 75GB memory. 

* Per concurrent client instance and in addition to any memory needed for the operating system and other 
applications that may run in parallel with this product. 

Definition of Typical/Average Use 
A user working with moderate-sized projects (2,000 – 5,000 activities), one project at a time, in either 
exclusive or shared mode, and using spreadsheet or bar chart views of moderate complexity.   

If the user is working with views in Open Plan that put a heavy demand on memory (for example, a bar 
chart view with many types of bars defined, a large number of “normal” calculated fields, or a smaller 
number of calculated fields that are calculation-intensive), larger amounts of memory will be used.   

In addition, for customers doing either Microsoft Project or Primavera integrations, Open Plan requires 
more memory.  

 

Hardware Requirements 
The number of people using Open Plan, the PM Compass processes they are using, and the size of your 
database all have an effect on the hardware and software requirements for your servers. 

 

Standalone Deployment 
The following table lists the recommended minimum hardware and software requirements for a 
deployment of Deltek Open Plan in standalone, workstation environment. 

Tier Hardware/Software Required Determining Factors 

Client Database Tier  Intel 2.0 GHz or higher 

 2 GB RAM  

Usage 

Integration Requirements 

Database Size 

Note: With the 32-bit version of Open Plan, a maximum of 3-4 GB may be used by the application 
due to operating system constraints. The 64-bit version of Open Plan can use up to 192 GB for the 
Professional, Enterprise, and Ultimate versions of Windows 7. 

Note: Specific server hardware configurations may have an impact on your overall Deltek product 
licensing requirements. Deltek recommends that you confirm with a Deltek Technical Sales Engineer 
that the server hardware you plan to deploy is in line with your Deltek license agreement and that you 
learn how overall server infrastructure expansion in the future may affect your Deltek licensing. 
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Tier Hardware/Software Required Determining Factors 

 10-20GB of available disk space 
for application, plus additional 
space for each project 

Database Growth 

Client/Server and Citrix/Terminal Server Deployment 
In the client/server model, you install the client and application tiers on workstations (or Citrix / Terminal 
Server) that directly connect to a database server.  

The following tables list the recommended minimum hardware and software requirements for a 
deployment of Deltek Open Plan in a client / server environment. 

Small Client/Server Installation: 1 - 25 Concurrent Users 

Tier Hardware/Software Required Determining Factors 

Database Server Class Machine: 
 Logical Cores 2.0+ GHz or faster CPU 

 8+ GB Physical Memory 

 High performance disk volume – SSD 
preferred 

 Database Size 

 Database Growth 

 Usage 

Application 
Server 
 

(Citrix/Terminal 
Server only) 

Server Class Machine: 
 4 - 8 x Logical Cores 2.5 GHz or faster 

CPU 

 8+ GB Physical Memory 

 125 MB of available disc space for 
application, plus additional space for 
each project 

 Total Users 

 Power Users 

 User Location 

 

Client Desktop Class Machine: 
 1.8 GHz or faster CPU 

 Recommend 4 GB Physical memory 

 530 MB of available disk space for 
application, plus additional space for 
each project 

 Monitor resolution must be at least 
1024×768 

 Applications running in 
client machine 

Medium Client/Server Installation: 25 – 50 Concurrent Users 

Tier Hardware Required Determining Factors 

Database Server Class Machine:  Database Size 
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Tier Hardware Required Determining Factors 
 8 x Logical Cores 2.8 GHz or faster CPU 

 8+ GB Physical memory 

 100 GB Hard drive 

 100 MB Network card 

 Database Growth 

Application 
Server 
(Citrix/Terminal 
Server only) 

 

Server Class Machine: 
 8 x Logical Cores 2.5 GHz or faster CPU 

 12 GB Physical memory 

 200 GB Hard drive space 

 125 MB of available disc space for 
application, plus additional space for 
each project 

 Total Users 

 Power Users 

 User Location 

Client  1.8 GHz or faster CPU 

 Recommend 4 GB Physical memory 

 530 MB of available disk space for 
application, plus additional space for 
each project 

 Monitor resolution must be at least 
1024×768 

 Applications running in 
client machine 

Large Client/Server Installation: 50+ Concurrent Users 

Tier Hardware Required Determining Factors 

Database Server Class Machine: 
 8 x Logical Cores 2.8 GHz or faster CPU  

 8+ GB Physical memory 

 100 GB Hard drive 

 High performance disk volume – SSD 
preferred 

 100 MB Network card 

 Database Size 

 Database Growth 

Application 
Server 
 
(Citrix/Terminal 
Server only) 

Server Class Machine: 
 8 x Logical Cores 2.5 GHz or faster CPU 

 16 GB Physical Memory 

 200 GB Hard drive space 

 125 MB of available disc space for 
application, plus additional space for 
each project 

 Total Users 

 Power Users 

 User Location 
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Tier Hardware Required Determining Factors 

Client Desktop Class Machine  

 1.8 GHz or faster CPU 

 Recommend 4 GB Physical memory 

 530 MB of available disk space for 
application, plus additional space for 
each project 

 Monitor resolution must be at least 
1024×768 

 Applications running in 
client machine 

 

Software Requirements 
The supported minimum software requirements for a complete installation of Deltek Open Plan are listed 
below. 

 

Supported Deployment Technology 

 

Supported Deployment Technology 

Operating System  Windows Server 2012 R2 

 Windows Server 2016 

 Windows Server 2019 

 Windows 8.1  

 Windows 10  

Citrix  XenApp 7.* (Windows Server 2012 R2) 

 XenApp 7.* (Windows Server 2016) 

 Citrix Virtual Apps and Desktop 7 (Windows Server 2019) 

VMWare Horizon  VMWare Horizon 7 

Database Platform Microsoft SQL Server 

Attention: For a complete list of the recommended minimum software requirements, see the Deltek 
Product Support Compatibility Matrix document that you can download from the Deltek Customer 
Care Connect site. 

Note: Supported versions are the current actively tested versions of technologies used to deploy 
Open Plan. Except for the Deltek Integrated Products, these technologies are not directly supported 
by Deltek. Changes to these technologies occur at the discretion of the individual technology vendors. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Supported Deployment Technology 

 SQL Server 2016 

 SQL Server 2017 (also supported on Linux and Unix) 

 SQL Server 2019 (also supported on Linux and Unix) 

 SQL Server Express 2016 

 SQL Server Express 2017 

 SQL Server Express 2019 

Oracle 
 Oracle 12.2 

 Oracle 18.3 

 Oracle 19.3 

Oracle is supported on Linux, Unix, and Exadata 

Microsoft Access 
 Microsoft Access 2013 

 Microsoft Access 2016 

 Microsoft Access 2019 

Database Driver Open Plan supports Access, Oracle, and SQL Server databases 
through an OLEDB 2.1 compliant provider. The data source providers 
to use for each database type are listed below. 

 Oracle Provider for OLE DB 

 MS SQL Server 2012 Native Client, version 11.4.7001.0 or 
higher 

 MS OLE DB Driver for SQL Server, version 18.2.2.0 or higher 

 Microsoft OLE DB Provider for Jet 

 Microsoft Office 12.0 Access Database Engine OLEDB 
Provider 

 Microsoft Office 15.0 Access Database Engine OLEDB 
Provider 

 Microsoft Office 16.0 Access Database Engine OLEDB 
Provider 

 

Scheduling Tools Microsoft Project Standard 

Note: The 64-bit version of Open Plan requires the 64-bit version 
of the Microsoft Access Database Engine. 

The 64-bit Microsoft Access Database Engine can be obtained 
from the Microsoft Download Center at the following location: 
https://www.microsoft.com/en-
us/download/details.aspx?id=13255. 

https://www.microsoft.com/en-us/download/details.aspx?id=13255
https://www.microsoft.com/en-us/download/details.aspx?id=13255
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Supported Deployment Technology 

 Microsoft Project Standard 2013 SP1 (Nov 10, 2015 update) 

 Microsoft Project Standard 2016 

 Microsoft Project Standard 2019 

Microsoft Project Professional 
 Microsoft Project Professional 2013 SP1 (Nov 10, 2015 

update) 

 Microsoft Project Professional 2016 

 Microsoft Project Professional 2019 

Microsoft Project Server 
 Microsoft Project Server 2013 SP1 (with update applied from 

KB 3115456) 

 Microsoft Project Server 2016 SP1 (with update applied from 
KB 4461598) 

 Microsoft Project Server 2019 

Oracle Primavera 
 Primavera P6 8.4 

 Primavera P6 17.12 

 Primavera P6 18.8 

 Primavera P6 19.2 

Kidasa 
 Kidasa Milestones Professional 2017 

 Kidasa Milestones Professional 2019 

 Kidasa Milestones Professional 2021 

Deltek Integrated Products The versions listed below are the minimum supported versions. 
Subsequent cumulative update (CU) releases within the listed 
major/minor release will be supported unless otherwise noted in the 
Technology No Longer Supported with this Release table. 
Subsequent major/minor releases are not supported. 
Deltek Cobra 

 Cobra 8.2 
 Cobra 8.3 
 Cobra 8.4  

Deltek Acumen 
 Acumen 8.5 
 Acumen 8.6 
 Acumen 8.7 

Deltek PM Compass 
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Supported Deployment Technology 

 PM Compass 8.1 

 
Deltek wInsight Analytics 

 wInsight Analytics 8.2 
 wInsight Analytics 8.3  

Embedded Technology  Visual C++ 2013 Redistributable Package (x86) 
 Visual C++ 2017 Redistributable Package (x86) 

.NET Framework  Microsoft .NET Framework 4.5.2 
 Microsoft .NET Framework 4.6 
 Microsoft .NET Framework 4.6.1 
 Microsoft .NET Framework 4.6.2 
 Microsoft .NET Framework 4.7 
 Microsoft .NET Framework 4.7.1 
 Microsoft .NET Framework 4.7.2 
 Microsoft .NET Framework 4.8 

Compatible Deployment Technology  

 

Compatible Deployment Technology 

Database Platform Microsoft SQL Server 
 SQL Server 2014 

 SQL Server Express 2014 

Oracle 
 Oracle 11.2 

Microsoft Access 
 MS Access 2010 

Citrix  XenApp 7.* (Windows Server 2012) 

Note: If you are integrating with PM Compass, you must use the 
32-bit version of Open Plan. 

Note: Compatible versions are the recent previously supported and tested technologies used to 
deploy Open Plan. These are not actively being tested but are believed to be compatible with Open 
Plan. Deltek does not recommend these technologies for new deployments but will make its best 
effort to answer questions concerning these technologies. These technologies may not be available 
for troubleshooting at Deltek. 
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Compatible Deployment Technology 

Scheduling Tool Oracle Primavera 
 P6 15.2 

 P6 16.2 

Kidasa 
 Kidasa Milestones Professional 2015 

Open Source Software Included with Open Plan 
Open Plan includes the following open source software:  

Software Company 

D3DES Public domain implementation of the Triple DES encryption algorithm  from 
the book "Applied Cryptography"  http://www.schneier.com/book-applied-
source.html 

Natural Sort Freeware sort algorithm.  http://sourcefrog.net/projects/natsort/ 

Pcrypt Public domain Password encryption based on D3DES 

PJNSMTP Freeware SMTP protocol library 
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Upgrade from Earlier Versions of Open Plan 
When upgrading from an earlier version of Open Plan, you must install Open Plan 8.5 in a new folder 
rather than attempting to overwrite/upgrade an existing Open Plan installation. Open Plan supports 
concurrent installations with previous versions of Open Plan, provided that: 

 The user has Administrator rights (This is necessary to enable Open Plan to update OLE 
Automation Server registration when different versions are used.) 

 The two versions do not share the same database 

 The two versions are installed to different folders 

It is necessary to perform a new Workstation installation for users that access Open Plan from a shared 
server installation. The Workstation setup application is available in the Workstation Setup folder of the 
server installation folder. 

Upgrade the Database 
Upgrading from an earlier version of Open Plan requires upgrading the database. Prior to upgrading, 
Deltek recommends backing up the Open Plan database. After you upgrade, you can no longer use the 
database with a prior version of the application. 

 

If you are upgrading … Use this upgrade script 

3.5 to 8.0  For SQL, run OPP80_Upgrade_SqlServer.sql 

 For Oracle, run OPP80_Upgrade_Oracle.sql 

8.0 to 8.1  For SQL, run OPP81_Upgrade_SqlServer.sql 

 For Oracle, run OPP81_Upgrade_Oracle.sql 

8.1 to 8.2  For SQL, run OPP82_Upgrade_SqlServer.sql 

 For Oracle, run OPP82_Upgrade_Oracle.sql 

8.2 to 8.3 No upgrade needed. 8.2 and 8.3 can use the same database 

8.3 to 8.4  For SQL, run OPP84_Upgrade_SqlServer.sql 

 For Oracle, run OPP84_Upgrade_Oracle.sql 

8.4 to 8.5  For SQL, run OPP85_Upgrade_SqlServer.sql 

 For Oracle, run OPP85_Upgrade_Oracle.sql 

Note: Before running the upgrade scripts for Oracle or SQL Server, your Database Administrator 
must verify if the Open Plan database is in Unicode. If so, the appropriate setting in the script to 
upgrade the database in Unicode must be set. 

If you are installing to a database that already contains Deltek Cobra or Deltek PM Compass, you 
must select the same Unicode option as the existing applications. 

After the upgrade, review Run Oracle Scripts for PM Compass Integration to see if it is necessary to 
run additional scripts to support integration with PM Compass. 
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Note: The update scripts used in this procedure can be found in the Open Plan installation folder. 

 MS SQL — You can find the scripts in the C:\Program Files (x86)\Deltek\Open Plan 
Professional 8.5\SQL\SQL Server folder. 

 Oracle — You can find the scripts in the C:\Program Files (x86)\Deltek\Open Plan 
Professional 8.5\SQL\Oracle folder. 

 MS Access — Open Plan does not support upgrading the Microsoft Access database used 
by a previous version of Open Plan. To transfer data from a previous version of Open Plan to 
the new version of Open Plan, perform a backup in the previous version of Open Plan and 
then perform a restore in the new version of Open Plan. 
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Install a Single-User Version of Open Plan 
This section describes how to install a 32-bit or 64-bit single-user version of Open Plan on either a stand-
alone PC or on a network drive. 

 

To install a single-user version of Open Plan, complete the following steps: 
1. Download the Open Plan Professional 8.5 software using the instructions in the Downloading 

Deltek Products using Deltek Software Manager section. 

2. Go to the location where you saved the Open Plan installer. 

3. Double click the appropriate installation package version to launch the installation wizard. 

 32-bit version of Open Plan — The installation package for the 32-bit version of Open Plan 
is DeltekOpenPlanProfessional85_x86.exe 

 64-bit version of Open Plan — The installation package for the 64-bit version of Open Plan 
is DeltekOpenPlanProfessional85_x64.exe 

4. On the Welcome to the Open Plan Professional 8.5 Setup Wizard page, click Next. 
5. On the Customer Information page, enter your user information and click Next.  

 
6. On the Change current destination folder page, select a destination for Open Plan by clicking 

the browse button, and click Next. 
7. On the Choose Setup Type page, select one of the following installation options:  

 Complete – Installs all Open Plan’s features. 

 Custom – Allows you to select or clear the individual Open Plan features.  
 Multi-User (Server) – Installs Open Plan to a network drive for shared use by multiple 

workstations. 

 
8. On the Ready to Install page, click Install. The system displays the installation’s progress. 

9. When the installation process is completed, click Finish on the Completing the Open Plan 
Professional 8.5 Setup Wizard page. 

The next step is to Start Open Plan for the First Time. 

 

Note: If you are integrating with PM Compass, you must install the 32-bit version of Open Plan. 

Note: For your Open Plan serial number and license key, please contact your Open Plan 
administrator. 

Note: Multi-User (Server) installation is covered in detail in the section entitled Perform a 
Multi-User Installation of Open Plan. 

If you do not choose to install a particular feature at this time, you can return to the 
installation wizard and add the feature later. 
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Perform a Multi-User Installation of Open Plan  
Creating a multi-user installation of Open Plan is a two-step procedure: 

 Performing a server installation 

 Performing a workstation installation for each licensed user 

Perform a Server Installation 
The purpose of the Multi-User (Server) installation is to allow multiple users to run the application from a 
shared network location. After performing the Server installation, each user must perform a Workstation 
installation in order to run the application from the shared network location. 

During the Multi-User (Server) installation, the destination folder path is written into the file Setup.ini 
located in the Workstation Setup folder. 

The destination folder path can be specified as either a UNC based \\server\folder path or a mapped 
drive:\folder path. Deltek recommends using a UNC-based path when performing a Multi-User (Server) 
installation. If a mapped drive:\folder path is used, you must ensure that all the user workstations use the 
same drive:\folder mapping. When performing an installation using a mapped drive, you must ensure that 
the Windows System account has access to the mapped drive because the Windows Installer uses the 
Windows System account when performing the installation. The Microsoft-recommended way to map a 
drive that is available to the Windows System account is to map the drive in an administrator command 
prompt using the Net Use command: 

net use <Drive Letter:> <UNC Path> /user:<User Name>  

Microsoft KB article 937624 explains the issue and workaround in more detail: 
http://support.microsoft.com/kb/937624 

Network Share Location 
After the Server installation, and before you perform a Workstation installation, verify that the path in the 
Setup.ini file points to the correct network share location because the Workstation installation will use this 
path to create shortcuts and perform application registration on the workstation. 

The line in Setup.ini looks like this:  

UNC \\Server\Folder path:  PROPERTIES=INSTALLDIR="\\<Server>\<Destination Folder> \" 

Drive:\Folder path:  PROPERTIES=INSTALLDIR="<Drive>:\<Destination Folder> \". 

To perform a 32-bit or 64-bit server installation, complete the following steps: 
1. Download the Open Plan 8.5 software, using the instructions in the Downloading Deltek Products 

using Deltek Software Manager section. 

2. Go to the location where you saved the Open Plan installer. 

3. Double click the appropriate installation package version to launch the installation wizard. 

 32-bit version of Open Plan — The installation package for the 32-bit version of Open Plan 
is DeltekOpenPlanProfessional85_x86.exe 

 64-bit version of Open Plan — The installation package for the 64-bit version of Open Plan 
is DeltekOpenPlanProfessional85_x64.exe 

4. On the Welcome to the Open Plan Professional 8.5 Setup Wizard page, click Next. 

http://support.microsoft.com/kb/937624
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5. On the Customer Information page, enter your user information then click Next. 

 
6. On the Change current destination folder page, select a destination for Open Plan by clicking 

the browse button, and click Next. 
7. On the Choose Setup Type page, select Multi-User (Server). 
8. On the Ready to Install page, click Install. The system displays the installation’s progress. 

9. When the installation process is completed, click Finish on the Completing the Open Plan 
Professional 8.5Setup Wizard page. 

10. Before you perform a Workstation installation, verify that the path in the Setup.ini file points to the 
correct network share location because the Workstation installation will use this path to create 
shortcuts and perform application registration on the workstation. 

The line in Setup.ini looks like this:  

UNC \\Server\Folder path:  PROPERTIES=INSTALLDIR="\\<Server>\<Destination Folder> \" 

Drive:\Folder path:  PROPERTIES=INSTALLDIR="<Drive>:\<Destination Folder> \". 

Perform a Workstation Installation 
After the server version of Open Plan has been installed on a network drive, use this procedure to 
perform multiple workstation installations. 

 You can only perform workstation installations from a server installation of Open Plan. 

 Although similar to the single-user installation, the workstation installation does not prompt you to 
enter a serial number and password. 

 You need to perform the workstation install on each computer that will be used to run Open Plan. 

 

To perform a workstation installation of Open Plan, complete the following steps: 
1. Verify that a server installation of Open Plan has already been placed on the network. 

2. Using Windows Explorer, locate the Open Plan server installation and navigate to the root folder 
for the workstation. For example, C:\Deltek\Open Plan Professional <version>\Workstation 
Setup. 

3. Double-click setup.exe to launch the installation wizard.  

4. On the Welcome to the Open Plan Professional <version> (Workstation) Setup Wizard 
page, click Next. 

5. On the Choose Setup Type page, select one of the following: 

 Administrator – the procedure installs all of the features of the Standard setup are together 
with the Security Administrator and the Data Tool. 

Note: For your Open Plan serial number and license key, please contact your Open Plan 
administrator. 

Important: Before you perform a Workstation installation, confirm that you have verified that the path 
in the Setup.ini file points to the correct network share location. For more information, see the final 
step in the Server Installation. 
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 Standard – the procedure installs the Open Plan Help system, documents, default access, 
data source, OLE setup, and Web Publisher. 

6. On the Ready to Install page, click Install. The Installing Open Plan Professional <version> 
(Workstation) page shows the installation’s progress. 

7. When the installation process is completed, click Finish on the Completing the Open Plan 
Professional <version> (Workstation) Setup Wizard page. 

 
The next step is to Start Open Plan for the First Time. 

Note: If you try to launch Open Plan after performing a workstation installation and receive an error 
saying the Data Sources could not be located, check that the paths to these files are mapped to the 
correct server. This is done by opening the Config.dat file located in the Open Plan root folder. 
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Start Open Plan for the First Time 
If you used the setup utility to install Open Plan, you can start the application on the Start menu. 

 
You must log on each time you launch Open Plan. You may log on to Open Plan for the first time as an 
administrator or a guest. 

To start Open Plan, complete the following steps: 
1. Click Start » All Programs » Deltek Open Plan <version> » Deltek Open Plan Professional 

<version>. 

2. On the Open Plan Login dialog box, log on as SYSADMIN or GUEST with the corresponding 
password. 

 Administrator: 

 User ID: SYSADMIN 

 Password: PASSWORD 

 Guest: 

 User ID: GUEST 

 Password: <blank> 

3. Click Login. 

If you will be using Open Plan with a Microsoft SQL Server or Oracle database,  the next step is to Set Up 
a Database. 

 
 

 

Note: To start Open Plan automatically each time you logon to Windows, drag the Open Plan 
application into the Windows Startup folder. For more information about the Startup program group, 
see your Windows documentation. 

Note: Open Plan is installed with a Microsoft Access database and does not require that you have an 
MS SQL Server or Oracle database in order to use the software. 
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Set Up a Database 
This procedure allows you to set up a database using either Oracle or SQL server. Make sure you have 
created a database to store the Open Plan tables before performing this procedure. 

Deltek recommends, as part of best practice, to install all products in the PPM suite into the same 
database. The installations apply schema changes (tables, views, stored procedures, and so on) to your 
existing database in order to support the integration. While it is highly recommended that you install 
wInsight and Acumen into the same database, the integration between PM Compass, Open Plan, and 
Cobra requires it. 

 

To set up the database, complete the following steps: 
1. Navigate to your Open Plan installation folder. 

2. Expand the contents of your Open Plan installation folder, and click the SQL folder. 

3. Open the subfolder that matches the type of database you want to set up: Oracle or SqlServer. 
4. Select the scripts to run based on whether you are using Oracle or SQL Server.  

If you are using Oracle, run the following scripts located in the Oracle subfolder:  

 Opp_Tables_Oracle.sql 

 WST_Tables_Oracle.sql  

If using SQL Server, run the following scripts located in the SQL Server subfolder: 

 Opp_Tables_SqlServer.sql 

 WST_Tables_SQLServer.sql 

 

Run Oracle Scripts for PM Compass Integration 
You must run the scripts listed below the first time you set up Open Plan in the same Oracle schema as 
PM Compass. 

 If your Open Plan installation is in the same schema as your PM Compass installation, you must 
run Opp_Oracle_CI_Indexes.sql.  

 If Open Plan was installed first followed by PM Compass, you must run both 
Opp_Oracle_CI_Indexes.sql and WST_Oracle_CI_Indexes.sql.  

Note: Open Plan supports Access, Oracle, and SQL Server databases through an OLEDB 2.1 
compliant provider. For information, see Appendix B: Open Plan Databases. 

Note: You must run the scripts in the Open Plan database that you created. 

The scripts for creating tables on Oracle and SQL Server default to a Unicode installation. 
You may edit the scripts to create non-unicode tables. See the scripts for instructions on 
changing the Unicode table options. 

The Oracle scripts include support for specifying the tablespaces for tables and indexes. See 
the Oracle scripts for instructions on changing the tablespaces that are used when creating 
tables and indexes. 
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 If PM Compass was installed first followed by Open Plan, you only need to run 
Opp_Oracle_CI_Indexes.sql. 

Script  Description Location 

Opp_Oracle_CI_Indexes.sql Run this script to create case-insensitive 
indexes in Open Plan tables for integration 
with PM Compass. 

For explicit Tablespace support, set the 
index_tablespace variable in the DECLARE 
section. 

To control the type of indexes that are 
created, see the indextype variable in the 
DECLARE section. 

\SQL\Oracle\Utility 

WST_Oracle_CI_Indexes.sql Run this script to create case-insensitive 
indexes on WST tables for integration with 
PMCompass. 

For explicit Tablespace support, set the 
index_tablespace variable in the DECLARE 
section. 

To control the type of indexes that are 
created, see the indextype variable in the 
DECLARE section. 

\SQL\Oracle\Utility 

The next step is to Set Up a Data Source for a New Database. 
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Set Up a Data Source for a New Database 
After you have created a database and the Open Plan tables, the database must be initialized before it 
can be used. The Deltek Open Plan Data Tool is used to set up the default system data, security data, 
and optionally, the demonstration data. 

To connect to a newly created database, you must add an Open Plan data source. An Open Plan data 
source has all the connection information that Open Plan needs in order to work with a database.  

Log Into the Deltek Open Plan Data Tool 

 

To log into the Deltek Open Plan Data Tool, complete the following steps: 
1. Click Start » All Programs » Deltek Open Plan <version> » Tools » Deltek Open Plan Data 

Tool.  
2. On the Data Tool Login dialog box, enter the password. (The default password as shipped from 

Deltek is password.) 

3. Click OK. The Deltek Open Plan Data Tool dialog box displays.  

Change the Deltek Open Plan Data Tool Password 

 

To change the Deltek Open Plan Data Tool password, complete the following steps: 
1. Click Start » All Programs » Deltek Open Plan <version> » Tools » Deltek Open Plan Data 

Tool.  
2. On the Data Tool Login dialog box, enter the password. 

3. Click Password. 

4. Enter a new password and confirm the new password. 

5. Click OK. 

Set Up a Data Source for a New Oracle Database 
Use the procedure in this section to set up an Open Plan data source for a new Oracle database. 

For Oracle, you can either set up an account (user name and password) that automatically restricts 
access to a specific schema, or use a general account and specify the schema name in the Edit Data 
Source dialog box. 

To set up an Open Plan data source for a new Oracle database, complete the following steps: 
1. Click Start » All Programs » Deltek Open Plan <version> » Tools » Deltek Open Plan Data 

Tool. 

Note: This procedure is not required for the supplied Microsoft Access database. 

Note: Deltek recommends that you change the password you used for login to prevent its 
unauthorized use. 
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2. On the Data Tool Login dialog box, enter the password. 

3. On the Deltek Open Plan Data Tool dialog box, click the Target DSN ellipses button. 

4. On the Data Sources dialog box, click Add. 

5. On the Provider tab of the Data Link Properties dialog box, select the appropriate database 
provider from the list. 

Open Plan supports the Microsoft OLE DB Provider for Oracle and the Oracle Provider for OLE 
DB.  Open Plan does not support the Microsoft OLEDB Provider for ODBC Drivers. 

6. Click Next. 
7. On the Connection tab, enter the following information: 

 Server name 
 Valid user name and password for the database 

 
8. Click Test Connection. 

9. When a message displays indicating that the connection tested successfully, click OK. 

10. Click OK on the Connection tab of the Data Link Properties dialog box. 

11. On the Edit Data Source dialog box, enter a name for the Open Plan data source and the 
Database Name (Schema). This field is used to identify the source. Leave this field blank if you 
are not using schemas or Access.  

12. The scripts for creating tables default to a Unicode installation. If the Open Plan tables were 
created as non-Unicode, clear the Database is Unicode option.  

13. Click OK. The new data source is added to the list on the Data Sources dialog box. 

14. Select the new data source, and click OK to return to the Deltek Open Plan Data Tool dialog box. 

Do not close the Deltek Open Plan Data Tool. You will need this tool to load default data. 

The next step is to Load Default Data. 

Set Up a Data Source for a New SQL Server Database 
Use the procedure in this section to set up an Open Plan data source for a new SQL database. 

To set up an Open Plan data source for a new SQL Server database, complete the following steps: 
1. Click Start » All Programs » Deltek Open Plan <version> » Tools » Deltek Open Plan Data 

Tool. 
2. On the Data Tool Login dialog box, enter the password. 
3. On the Deltek Open Plan Data Tool dialog box, click the Target DSN ellipses button. 
4. On the Data Sources dialog box, click Add. 

Note: If you want to save your user name and password, select the Allow saving Password 
option. Select Blank Password only if your user name does not have an associated 
password. 
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5. On the Provider tab of the Data Link Properties dialog box, select the appropriate database 
provider from the list. 

 
6. Click Next. 
7. On the Connection tab, enter the following information: 

 Server Name – Select or enter the appropriate server name. 
 Information to log on to the server – Select whether to use Windows NT Integrated 

Security or to use a specific user name and password. If you elect to use a specific User 
name and Password, enter a valid user name and password for your database. 

 Blank password – Select this option only if your user name does not have an associated 
password. 

 Allow saving password – Always select this option. Both the user name and password are 
encrypted and the information is stored in the Datasources.dat file along with the connection 
properties. If this option is not selected, the users are prompted to log into the database each 
time they launch Open Plan and they may encounter database errors. 

 Select the database on the server – Select the appropriate database to use on the server 
by default. This name is used to identify the data source in the Data Sources dialog box. 

 Attach a database file as a database name – Select this option if you want to attach a 
database file directly. 

 
8. Click Test Connection. 
9. When a message displays indicating that the connection tested successfully, click OK.  
10. Click OK on the Connection tab of the Data Link Properties dialog box. 
11. On the Edit Data Source dialog box, enter a name for the Open Plan data source.  
12. If you selected a database name on the Connection tab of the Data Link Properties dialog box, 

leave the Database Name (Schema) field blank if you are not using schemas or Access. 
13. The scripts for creating tables default to a Unicode installation. If the Open Plan tables were 

created as non-Unicode, clear the Database is Unicode option.  
14. Click OK. The new data source is added to the list on the Data Sources dialog box. 
15. Select the new data source, and click OK to return to the Deltek Open Plan Data Tool dialog box. 

Do not close the Deltek Open Plan Data Tool. You will need this tool to load default data. 

The next step is to Load Default Data. 

Note: Open Plan supports the Microsoft OLE DB Provider for SQL Server and the SQL 
Server Native Client. Open Plan does not support the Microsoft OLE DB Provider for ODBC 
Drivers. 

Note: If you want to save your user name and password, select the Allow saving Password 
option. 
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Load Default Data 
Use the Deltek Open Plan Data Tool dialog box to set up default data. Using this dialog box, select the 
data source you created in the Edit Data Sources dialog box from the Target DSN field. 

 
Select the appropriate fields on the Deltek Open Plan Data Tool dialog box: 

 The Install default data option needs to be run only once for a data source. It will refresh the 
data dictionary, security data, system library, explorer folders, spread curves, views, title blocks, 
bar sets, and symbols. 

 If you select the Remove existing data option, all data in the data source will be removed before 
the default data is installed. 

 The Install demonstration data option installs the demonstration projects Clean, Constr, 
Develop, Movie, Movie15, Pharmacy, STS-65, Ship, and Tour. To install the demonstration data, 
you must select the Remove Existing Data option. 

To load default data, complete the following steps: 
1. Click Start » All Programs » Deltek Open Plan <version> » Tools » Deltek Open Plan Data 

Tool. 
2. On the Data Tool Login dialog box, enter the password. 

3. On the Deltek Open Plan Data Tool dialog box, in the Target DSN field, select the data source 
that you previously set up and click OK. 

4. Select Install Default Data.  

 
5. Click Create Data.  

6. After the data has been created, click Close.  

 

Note: Running the data tool erases all data of the specified type in the data source that you use it 
against. 

The data tool cannot be run on data sources that have PM Compass installed. The options and the 
Create Data button are disabled when PMCompass is detected in a data source. 

Note: To install the demonstration data, select Remove Existing Data, and then select 
Install Demonstration Data. 
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Create Users and Groups 
Use the Deltek EPM Security Administrator to create users and groups, and add users to the groups.  

 

To launch the Deltek EPM Security Administrator:  
1. Click Start » All Programs » Deltek Open Plan <version> » Security » Deltek EPM Security 

Administrator.  

2. Select a data source, and click OK.  

3. On the EPM Security Administrator Login dialog box, enter your User ID and password, and click 
OK.  

The next step is to Give Users the Appropriate Open Plan Folder Permissions. 

Attention: For more information, see the Deltek EPM Security Administrator online help. 
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Give Users the Appropriate Open Plan Folder 
Permissions 
When installing Open Plan Professional on a network, the following network access rights must be 
provided to users: 

Open Plan Professional Folder Required Access Rights 

Opp Read 

\Documentation Read 

\Help Read 

\Sample Data Read 

\Sample Tools Read (or write if the users want to modify the sample source 
code) 

\Spell Write (to add words to dictionary) 

\SQL Read (Write to use the default Access database) 

\Symbols Read 

\User Read 

\Workstation Setup 

(Server installations only) 

Read 
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Modify, Repair, or Uninstall Open Plan 
Open Plan provides facilities for changing which features are installed, repairing installation errors, and 
removing Open Plan. Use the procedure in this section to change your Open Plan installation structure.  

To modify, repair, or remove your Open Plan installation, complete the following steps: 
1. Launch the MS Windows Control Panel. 

2. Click Programs and Features.  

3. On the Programs and Features list, right-click Deltek Open Plan Professional <version> and 
click Change on the context menu. The Deltek Open Plan Professional <version> Setup Wizard 
displays. 

4. Click Next. 
5. On the Modify, Repair, or Remove Installation page, select one of the following options, 

depending on the task that you want to do: 

 Modify — Select this option to change your Open Plan installation structure. Selecting this 
option displays the Custom Setup page. 

 Repair — Select this option to repair installation errors by reinstalling the Open Plan 
components. Selecting this option displays the Repair Deltek Open Plan Professional 
<version> page. Click Next to repair Open Plan. 

 Remove — Select this option to uninstall Open Plan from your machine. Selecting this option 
displays the Remove Deltek Open Plan <version> page. Click Next to uninstall Open Plan. 

6. When the process is complete, click the Finish button to exit the Setup Wizard. 
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Next Steps 
Open Plan includes a number of tools to help you learn about the features and operations of the product. 

Guided Tour 
To help you get up to speed as quickly as possible, Open Plan provides a guided tour that includes 
several facilities designed to introduce you to the basic operations of the package. The tour uses sample 
project data that comes with your installation to introduce you to the basics of Open Plan. There is no 
substitute for a hands-on encounter with the software, and that is what this tour is designed to provide. 
For information, see the Deltek Open Plan Guided Tour Guide. 

Online Help 
Use the Getting Started with Open Plan topics in the online help to familiarize yourself with the Open Plan 
features and processes. 

Developer Guide 
For in-depth information about advanced topics, review the Deltek Open Plan Developer Guide which 
includes information on topics such as customizing project views, data file structures, compatibility issues, 
and OLE automation techniques. 

Training Courses 
For information on Open Plan training courses, visit our Web site at www.deltek.com. Click Learn » 
Deltek University » Browse Courses. In the Deltek Learning Zone, click on the Open Plan icon. You 
can learn more about training and browse for specific courses on that page. 

 

https://www.deltek.com/en/
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Troubleshooting 

System Error When Launching Open Plan 
The following error might display when you launch Open Plan: “The program can’t start because api-ms-
win-crt-runtime-l1-1-0.dll is missing from your computer. Try reinstalling the program to fix this problem.” 

If this error occurs when launching Open Plan, you need to download and install the Universal C Runtime 
for Windows from Microsoft.  

Microsoft KB article 2999226 provides information about how to download and install this update: 

https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows. 

Open Plan Crashes When you Open the Network View 
If Open Plan crashes when you open the network view, verify that the print spooler is running and that 
you have a configured printer. 

To start the print spooler, complete the following steps: 
1. Navigate to Administrative Tools » Services. 
2. Locate the Print Spooler service. 
3. Right-click and select Start. 

To confirm that there is a configured printer for Open Plan, complete the following steps: 
1. Launch Open Plan. 

2. Click File » Print » Print and confirm that you can select a printer. If there is no printer, you need 
to connect to one. 

To select a network printer for Open Plan, complete the following steps: 
1. Launch Open Plan. 

2. Click File » Print » Print Setup.  

3. Click Network and select a network printer. 

Custom Tools Are Not Connecting to Open Plan 
When you develop a custom tool that uses the Open Plan API, you may need to manually register the 
Open Plan .exe file in order for the tool to connect to Open Plan. 

You can do this by opening a Command Prompt window and running: openplan /register. 

SQL Server Connection Errors 
 Microsoft OLE DB Provider — If your database server requires a secure connection, and you 

are using the default Microsoft OLE DB provider for SQL Server, you may see the following error 
when you log into Open Plan: 

 

https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
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In order to resolve the issue, install the SQL Server Native Client and then follow the steps below.  

 SQL Server Native Client — When you use SQL Server Native Client and specify a database 
username and password, you may see the following error when you log into Open Plan: 

 
You must complete the steps below in order to get the data source to remember the password.  

To resolve the SQL Server connection errors: 

 
1. In Open Plan, click File » Preferences » Data Sources. 

2. Select the data source and click Edit. 
3. Click Data Link Properties. 

4. On the Provide tab, select SQL Server Native Client <version> and click Next. 
The Microsoft ODBC driver is not supported and does not display in this list. 

 
5. On the Connection tab: 

a. Select or enter a server name. 

b. Enter your SQL Server username and password. To enter the password, you will need to 
clear Blank Password and select Allow saving password. 

Note: You will need to complete these steps any time you create or edit the properties in the Data 
Link Properties dialog box for the SQL Server Native Client. 
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c. Select the database. 

 
6. On the All tab, scroll down to Persist Security Info. 

7. Double click the option and select True in the Property Value field. 
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8. Click OK to close to the property dialog box. 

9. Click OK to close the Data Link Properties dialog box. 
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Appendix A:  Open Plan Terminal Services 
(Remote Desktop Services)/Citrix Installation  
This appendix is designed to explain the additional steps required to install Open Plan in a shared 
application server (MS Terminal Server/Remote Desktop Services or Citrix XenApp Server) environment. 

Version Information 
Beginning with Windows Server 2008 R2, Terminal Services was renamed Remote Desktop Services. In 
addition to the name change, the deployment and configuration of Remote Desktop Services have 
changed significantly. For guidance on deploying the Remote Desktop Services Role and Features, refer 
to the Microsoft Remote Desktop Services documentation page (https://technet.microsoft.com/en-
us/windowsserver/ee236407).   

 
Many customers use Open Plan on Citrix XenApp Server. Citrix offers more sophisticated load balancing 
capabilities and provides solutions for cross platform remote access. 

Important Information 
For improved application performance, Deltek strongly recommends that all application software be 
accessed in a Terminal Server/Remote Desktop Services environment installed locally on the Terminal 
Server/Remote Desktop Session Host application server. For Windows 2008 R2 or higher, when 
deploying the Remote Desktop Services role, the session-based desktop deployment scenario is 
recommended and is comparable to the deployment of Windows Terminal Services of Windows 2008 and 
earlier versions. 

Database Connections 
The two most important factors affecting Open Plan performance are memory available to the application 
and database performance. Deltek recommends that Open Plan Professional be used with either SQL 
Server or Oracle in a multi-user environment and that the database server be close to the Terminal 
Server/Remote Desktop Session Host application server. Smaller implementations can install the 
database software on the Terminal Server/Remote Desktop Session Host itself but for larger 
implementations (more than 10 users) we recommend a separate database server. We suggest that the 
Terminal Server and database server be connected to the same network switch and that if the solution 
will be supporting many users, then serious consideration should be given to a Gigabit link. 

Server Sizing 
We recommend that you follow the application server supplier guidelines for server sizing. Open Plan falls 
into the knowledge worker category for sizing purposes. In the absence of other advice Deltek suggests 
200MB for the system and 50MB per concurrent user. Accepted wisdom is that one fast processor is 
more advantageous than 2 slow processors so we would suggest considering a dual 3 GHz solution over 
a quad 1.5 GHz solution (a quad 3 GHz is better). 

Note: In this appendix, the terms “Terminal Services” and “Remote Desktop Services” are used 
interchangeably. 

https://technet.microsoft.com/en-us/windowsserver/ee236407
https://technet.microsoft.com/en-us/windowsserver/ee236407
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Terminal Server/Citrix Installation  
The recommended approach for Terminal Server/Citrix installation is to install the application locally on 
the server using the Complete installation option. The appropriate menu options will be added for all 
users. Terminal Server/Citrix will automatically create appropriate registry entries for each user. Open 
Plan Professional will automatically create the required user files when first launched in the users My 
Documents folder.  

 
When a Terminal Server is in Application Server mode (required to support remote access by more than 2 
users) the Server must be placed into Installation Mode so that it will correctly copy application registry 
keys for new users. The correct way to enter Installation Mode is to use the Programs and Features 
option in the Control Panel. 

In Programs and Features, find and double-click Deltek Open Plan Professional <version>.exe. 
Select the Complete Installation. 

Security Considerations 
Make sure the users requiring Remote Desktop access are members of the Remote Desktop Users group 
or that the users have been granted Terminal Server logon rights through the local security policy 
(Administrative Tools; Local Security Policy). 

 
The limited user group must be granted MODIFY access to the default MS Access database if this will be 
used.  

Attention: For details on how to change this behavior, see Modifying the User Directory. 
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If this data source will not be used then the Administrator must update the Open Plan 
DATASOURCES.DAT file with the appropriate connection settings for the required database. 

Logon as the limited user 
Run Open Plan (menu and desktop items should automatically appear). 

The user’s My Document folder will be updated to include a Deltek folder containing the Open Plan 
working files, including the BRIEFCASE database and SPELLING DICTIONARIES, among others. 

  

Modifying the User Directory 
Open Plan defaults to creating the user working directory as a subfolder of the current users My 
Documents\Deltek folder. It is possible to globally modify this behavior by adding the following line to 
CONFIG.DAT in the root of the Open Plan installation. 

[SYSTEM] 
UserDir=N:\OPP 
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This would cause Open Plan to create the Open Plan files in the folder N:\OPP. It is the System 
Administrator’s responsibility to ensure that this represents a unique location for each user. This means 
that typically Drive N: must be mapped as part of the login process, taking care to map to a different 
physical folder for each user. 
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Appendix B: Open Plan Databases 

Access 
A default Access database is automatically created when Open Plan is installed and Open Plan is 
configured to use this database by default. 

Oracle and SQL Server 
If you prefer to have Open Plan use an Oracle or SQL Server database, you first need to create tables 
and define a data source. When you configure an SQL database, you must consider several aspects 
regarding the database itself: 

 Database size 

 Transaction log size 

 Database permissions 

Refer to your Oracle or MS SQL documentation for information on how to create a database. 

Upgrading the Database 
Upgrading from an earlier version of Open Plan requires upgrading the database. The update scripts are 
located in the Open Plan executable folder. For more information, see Upgrade from Earlier Versions of 
Open Plan. 

Database Size 
When creating the Open Plan database, you must consider the number of anticipated project elements 
that will be created in Open Plan and the number of records the project elements will contain. Generally, 
each project activity uses 3000-4000 bytes. Each project baseline adds an additional 2000-3000 bytes 
per project activity. Note records contain variable length free-form text and can add up to an additional 
32,000 bytes for each note in use. 

Following these rules, a typical 1000-activity project with two baselines and notes containing 200 bytes of 
text on 20% of the activities would require approximately 10 MB of disk space, not including database-
specific overhead. You can use the Excel spreadsheet (sizing30.xls) located in the Open Plan destination 
folder to help estimate disk requirements. 

Transaction Log Size 
Open Plan performs updates on large numbers of database table rows when saving changes to project 
data. Transaction logs must be sized appropriately to allow for these types of operations. 

Database Permissions 
To create and modify project elements in the database, you must have the following permissions on the 
Open Plan tables: SELECT, INSERT, UPDATE, DELETE, and EXECUTE. 

It is not necessary to create a separate user account for each Open Plan user on the database, nor is it 
necessary for users to see the database login prompts. 
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Appendix C:  Deltek Open Plan Professional 
Folder and Files 

Start Menu 
In addition to a shortcut to the Open Plan application, the installation creates several folders with 
shortcuts under the Deltek Open Plan <version> folder. 

Documentation 
The following reference materials are available in the Documentation and Help folders: 

 Open Plan Help System  – The Open Plan context-sensitive help system. 

 Open Plan Release Notes – A document that discusses the new features and enhancements of 
this release, changes to the documentation, and the Software Issues Resolved. 

 Open Plan Guided Tour — A document that introduces you to the basic Open Plan operations 
using sample project data that comes with your installation. 

 Open Plan Developer Guide – A reference manual for more technical topics in Open Plan. 

 Open Plan Batch Processor Guide — Information about running the Open Plan multi-instance 
batch processor. 

Security  
EPM Security Administrator – The EPM Security Administrator allows you to define the security rights 
for Open Plan. EPMSecAdmin.exe is installed in the root of the Open Plan installation folder.  

Tools  
Deltek Open Plan Data Tool – A utility to set up the default system data, security data, and optionally, 
the demonstration data.  OpenPlanDataTool.exe is installed in the root of the Open Plan installation 
folder. 
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Appendix D: If You Need Assistance 
If you need assistance installing, implementing, or using Deltek Open Plan, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 
For over 30 years, Deltek has maintained close relationships with client firms, helping with their problems, 
listening to their needs, and getting to know their individual business environments. A full range of 
customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Deltek Support Center. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 
 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 
 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 

Deltek Support Center Community 
 Access Cloud-specific documents and forums 
 Download the latest versions of your Deltek products 
 Search Deltek’s knowledge base 
 Submit a support case and check on its progress 
 Transfer requested files to a Customer Care analyst 
 Subscribe to Deltek communications about your products and services 
 Receive alerts of new Deltek releases and hot fixes 
 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Attention: Find out more about these and other services from the Deltek Support Center. 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 
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Access Deltek Support Center 
To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Additional Documentation 
The following table lists the Deltek documentation available for this release. Except where noted, all the 
user guides and quick reference guides listed in this table are available for download from the Deltek 
Support Center. 

Document Name Description 

Deltek Open Plan Batch Processor Guide This document contains information about running 
the Open Plan multi-instance batch processor. 

Deltek Open Plan Developer’s Guide This document is meant to serve as a reference 
manual for more technical topics in Open Plan. 

Deltek Open Plan Guided Tour This document introduces you to the basic Open 
Plan operations using sample project data that 
comes with your installation. 

Deltek Open Plan Milestone Professional 
Interface Add-In Module 

This document is meant to serve as a guideline for 
using the Milestones Link tool. 

Deltek Open Plan Release Notes This document contains a summary of the pre-
installation information, rew features and 
enhancements, database changes, and software 
issues resolved. 

Deltek Open Plan Technical Overview and 
System Requirements 

This document is meant to serve as a guideline for 
hardware and software requirements and provide 
your firm’s IT department with information about 
the technical deployment architecture. 

 

 

 

 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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